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1. INTRODUCTION 
The Macaulay Land Use Research Institute (MLURI), since April 2011 The James Hutton 
Institute, developed the Phosphorus Land Use and Slope (PLUS) model in the 1990’s in 
association with the Forth River Purification Board and with funding assistance from Scottish 
Natural Heritage. In conjunction with a hindcasted national land cover (circa 1850) dataset 
PLUS attempted to discern the relationship between anthropogenic drivers of nutrient 
enrichment (especially Phosphorus [P]) and trophic status of standing waters in Scotland. 
This effort was carried out for 170 lochs and proved to be a robust investigation. There was 
interest in using the model to undertake further assessment of loch phosphorus 
concentrations and how these are affected by changes in land cover and point sources of P. 
However, the PLUS model was based on old GIS technology and lacked any kind of user 
friendly interface as well as no facilities for maintaining records of simulations in a central 
database. Work has recently been completed to address these issues and this report aims to 
provide a user guide to aid utilization of the model via the new user interface. 
 
While appropriate checks and precautions have been taken during design, execution and 
testing of PLUS+, The James Hutton Institute cannot be held responsible for any 
consequences arising from the use or miss-use of the model, or any part therein. Users of 
PLUS+ are strongly advised to confirm the results obtained from PLUS+ using an alternative 
method of calculation. 
 

2. SCOPE OF THE MODEL 

2.1 Purpose 
PLUS+ is a GIS based system that provides the ability to investigate present day P 
concentrations in standing waters in Scotland through source apportionment techniques. The 
model has the potential to be used in investigating consents, sensitivity analysis and 
scenario analysis using changing land cover situations and point source P, storing input and 
output parameters in a centralized database. 

Scenario modelling options include: 

- Land cover 
 Ability to overlay new land cover data. 
 Ability to change P loss coefficients. 
 Ability to make bulk changes to land cover areas. 

- Point sources 
 Ability to change waste water treatment works (WWTW) P input 

through altering urban population and loss coefficient. 
 Ability to change septic tank P input through altering rural population 

and loss coefficient. 
 Addition of total P from other point sources. 

It is emphasised that the model is designed to consider standing waters. 

2.2 The model structure and data 
The application uses the ArcMap Table of Contents (‘Display’ and ‘Source’, see below) to 
access data.  
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In order to be used in the application the tables, shape files and feature classes must first be 
loaded into the Table of Contents. The application uses the path to the data which is stored 
by ArcMap in the table of contents, giving flexibility of data location, including access to files 
across networks, and avoids issues of data concurrency. 
 
There are two ESRI personal geodatabases (PGDB): SourceData.mdb and 
ScenarioData.mdb. SourceData.mdb contains the following tables: 

1. CatchmentSewage (Urban and rural populations and their associated P load) 
2. CatchP (Land cover type and area and associated P) 
3. Exports (P look up table for land cover/slope combinations) 
4. FlowRouting (Loch flow relationships) 
5. LoadPrecursor (Loch attributes) 
6. PerCapitaTPLoads (P look up table for urban and rural P load) 
7. TPBreakPoints (Water quality P break points) 

and the following feature classes: 
1. LocalCatchment_and_Network (Catchment polygons, and their attributes) 
2. SlopeClass_LandCover (Land cover/slope polygons) 

Additionally the following tables containing SEPA monitoring information are required: 
1. SEPA_detailed_Loch_WB_classification (loch classifications for WBID) 
2. SEPA_20XX_loch_class (measured P concentration for specified years XX) 

ScenarioData.mdb largely duplicates the SourceData above but with names suffixed with 
“_S” to denote scenario tables. SlopeClass_LandCover and FlowRouting are not included as 
they will not be modified. Additionally ScenarioData.mdb includes a table “Scenario”. This 
table contains all the information to identify and describe the scenario: 

1. ScenarioID 
2. ScenarioName 
3. ScenarioCreator 
4. ScenarioCreationDate 

Table of contents 
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5. Comment 
6. Region 

Note that the two SEPA monitoring tables are not duplicated within the scenario structure so 
that whether the baseline data or scenario data are being loaded the SEPA tables must be 
selected first. Additionally, the measured values are not incorporated in the PLUS+ modelling 
calculations, they are included in the reports and output windows for information and 
comparison with the modelled values. 
 
Point sources of P added to the model by a user through PLUS+ will be stored in the 
scenario table PointSource_S. Any number of point sources may be added by the user (only 
subject to operating system and database restrictions). This table can also be edited 
manually to add point sources to a scenario. The scenario database does not include a 
“FlowRouting” table as the topological relationships of lochs will not be modified by any of the 
scenario creations.  

As detailed above, the input and output tables and feature classes are contained in these two 
personal geodatabases. The software has been written around the use of geodatabases and 
it is necessary to use these to store the data sets. Attempting to use standalone tables (i.e. 
tables not stored in a geodatabase) for scenarios will cause the software to crash. However, 
standalone shapefiles may be used to import modified land cover and the output from the 
processing of the overlay of the new land cover and the base line land cover will be saved to 
a user-specified standalone shapefile. 

The tables and feature classes in ScenarioData.mdb have the same attribute structure as 
SourceData.mdb, but with the addition of an attribute “ScenarioID” in each case. This is used 
to link to the “Scenario” table in the database. These tables are used to store the attribute 
values from the user created scenarios (including overlays of new land cover data), whether 
modified or copied from the SourceData.mdb tables. 

The application uses a SEPA produced table containing its annually updated loch 
classifications. PLUS+ searches the table of contents (or source tab) for tables with “SEPA” 
in their name and adds them to the relevant drop-down menu to allow the user to choose the 
correct table or to enable modelling the effects with different tables. Within PLUS+ the 
following field names are expected to be found in the table that the user selects: 
WATER_BODY_ID and STATUS. The application also uses a SEPA look up table to 
translate between GB Lakes and Water Body identifiers. In this table the expected field 
names are: WB_ID and WG_WBID. The application will generate an error message if these 
fields are not found in the table selected by the user. Note that these tables are also used 
when data has been loaded from a scenario, so please ensure that it they are selected. 

SEPA periodically revises the water body breakpoint values. To ensure that PLUS+ is always 
using the most recent data a second Visual Basic tool has been supplied – 
frmUpdateBreakPoints. This can be run in the same manner as PLUS+. The user must 
select the existing breakpoints table from SourceData.mdb (TPBreakPoints), a look-up-table 
to relate the waterbody ID’s and the GB Lakes IDs and the table of updated data. Once the 
user has selected a table the secondary drop down menus will be populated with the 
available fields in the table. The revised breakpoint data is to be of the following format: 
individual records for each of five water quality standards for each water body (so five 
records for each water body), a field containing the water body ID, a lower limit field, an 
upper limit field and a numerical field with a value of 1 corresponding to Poor and 5 
corresponding to High. Please note that clicking on “Update breakpoints table” will overwrite 
the table in the SourceData database, so please make a back-up of the table first. PLUS+ 
will use the TPBreakPoints table in all calculations (including RAG assessment), so please 
ensure that it contains the correct data. 
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2.3 Method utilised by model to calculate phosphorus concentrations 
2.3.1. Calculation of land cover Phosphorus load 

Land Cover of Scotland 1988 (LCS88 data) has been used to represent land cover. Each 
land cover area was subdivided based on its slope (calculated using Ordnance Survey 
elevation data) into three slope classifications, low medium and high, see Table 1 for the 
thresholds used. 

Table 1 Slope classification thresholds 

Low 0-4 degrees  
Medium 4-13 degrees 
High 13+ degrees 

Phosphorus export coefficients were then assigned for each slope category for each land 
cover type. The default export coefficients used in PLUS+ are the average of those 
developed collaboratively between MLURI and the Forth River Purification Board (Table 2). 
These loss coefficients were calibrated in a project completed for SNIFFER by Ferrier et al. 
(1996) for all the lochs in the 1995 quinquennial Scottish Water Quality Survey scheme by 
back calculating the total P load into the waterbody from the best available estimate of total P 
concentration in the lochs. 

 

Note that the original PLUS model calculated the range of possible P loads based on the 
minimum and maximum values in Table 2, but that the current version of PLUS+ uses only 
the mean value and calculates a single load and concentration. It should be considered 
whether future versions of PLUS+ should incorporate these export coefficient ranges. 
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Table 2 Land cover and slope P export coefficients (kg ha-1) 

Land 
cover 
code 

Land Cover 
Description 

Export Coefficient for each slope classification 
Low (Slope code 100) Medium (Slope code 200) High (Slope code 300) 

Match 
Code Min Max Av. 

Match 
Code Min Max Av. 

Match 
Code Min Max Av. 

1 water 101 0.07 0.20 0.135 201 0.00 0.00 0.000 301 0.00 0.00 0.000 
2 wetland 102 0.02 0.15 0.085 202 0.00 0.00 0.000 302 0.00 0.00 0.000 

3 
blanket bog 
& peatland 103 0.01 0.03 0.020 203 0.02 0.04 0.030 303 0.03 0.05 0.040 

4 arable 104 0.40 1.08 0.740 204 0.74 1.54 1.140 304 1.08 2.00 1.540 

5 
improved 
grassland 105 0.20 0.44 0.320 205 0.32 0.62 0.470 305 0.44 0.80 0.620 

6 
coarse 
grassland 106 0.04 0.08 0.060 206 0.06 0.12 0.090 306 0.08 0.15 0.115 

7 
smooth 
grassland 107 0.04 0.08 0.060 207 0.06 0.12 0.090 307 0.08 0.15 0.115 

8 
heather all 
types 108 0.04 0.08 0.060 208 0.06 0.12 0.090 308 0.08 0.15 0.115 

9 bracken 109 0.04 0.08 0.060 209 0.06 0.12 0.090 309 0.08 0.15 0.115 
10 cliffs 110 0.00 0.00 0.000 210 0.00 0.00 0.000 310 0.01 0.08 0.045 

11 
montane 
vegetation 111 0.01 0.04 0.025 211 0.02 0.06 0.040 311 0.04 0.08 0.060 

12 low scrub 112 0.10 0.18 0.140 212 0.14 0.24 0.190 312 0.18 0.30 0.240 

13 
broadleaved 
woodland 113 0.10 0.20 0.150 213 0.15 0.28 0.215 313 0.20 0.35 0.275 

14 
mixed 
woodland 114 0.08 0.17 0.125 214 0.12 0.23 0.175 314 0.17 0.30 0.235 

15 
coniferous 
plantation 115 0.06 0.14 0.100 215 0.10 0.19 0.145 315 0.14 0.25 0.195 

16 

recently 
ploughed 
land 116 0.40 0.72 0.560 216 0.56 0.96 0.760 316 0.72 1.20 0.960 

17 

woodland 
recently 
felled 117 0.20 0.52 0.360 217 0.36 0.76 0.560 317 0.52 1.00 0.760 

18 

open canopy 
young 
plantation 118 0.08 0.17 0.125 218 0.12 0.23 0.175 318 0.17 0.30 0.235 

19 ripping 119 0.25 0.35 0.300 219 0.30 0.43 0.365 319 0.35 0.50 0.425 
20 estuary 120 0.00 0.00 0.000 220 0.00 0.00 0.000 320 0.00 0.00 0.000 
21 salt marsh 121 0.00 0.00 0.000 221 0.00 0.00 0.000 321 0.00 0.00 0.000 
22 duneland 122 0.00 0.00 0.000 222 0.00 0.00 0.000 322 0.00 0.00 0.000 

23 

maritime 
grasslands & 
heaths 123 0.00 0.00 0.000 223 0.00 0.00 0.000 323 0.00 0.00 0.000 

24 airfields 124 0.00 0.00 0.000 224 0.00 0.00 0.000 324 0.00 0.00 0.000 

25 
recreational 
land 125 0.00 0.00 0.000 225 0.00 0.00 0.000 325 0.00 0.00 0.000 

26 quarries 126 0.00 0.00 0.000 226 0.00 0.00 0.000 326 0.00 0.00 0.000 

27 
factories & 
urban 127 0.80 1.96 1.380 227 1.38 2.83 2.105 327 1.96 3.70 2.830 

28 other land 128 0.00 0.00 0.000 228 0.00 0.00 0.000 328 0.00 0.00 0.000 
29 road & rail 129 0.00 0.00 0.000 229 0.00 0.00 0.000 329 0.00 0.00 0.000 
0 NULL 100 0.00 0.00 0.000 200 0.00 0.00 0.000 300 0.00 0.00 0.000 
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2.3.2. Calculation of point source Phosphorus load 

The default model output is based on the 2001 census data for which a population density of 
0.3 people per hectare has been used to define a threshold between urban and rural 
population. All waste water for urban populations is assumed to reach the surface water body 
via waste water treatment works (WWTW) and a per capita P load rate (loss coefficient) has 
been defined by default as 0.9125 kg P per capita. Waste water from rural populations is 
assumed to enter the surface water body via septic tanks and a per capita P load rate (loss 
coefficient) has been defined as a default value of 0.25 kg P per capita. 

Table 3 Default point source values 

Rural/urban population threshold 0.3 per hectare 
Urban Loss Coefficient 0.9125 per capita 
Rural Loss Coefficient 0.25 per capita 

It is assumed that the entire population within the local catchment and only the population 
within the local catchment contributed P to the surface water. Population in the network of 
connected catchments is routed via any upstream linked surface water body using the 
FlowRouting table and information in the LocalCatchment_and_Network feature class to 
identify the flow network. The actual location of the WWTW is not modelled in PLUS+. 

2.3.3. Calculation of surface water total P concentration 

Firstly the overall total P load to a waterbody is calculated from summing the estimates of 
point sources, land cover total P load (see section 2.3.1 and 2.3.2) and P from upstream 
lochs. This total load is then used to calculate an in-lake total P concentration using OECD 
(Eutrophication of Waters, Paris 1982) equations (equation 1). 

b

WT
RJaTP 











+
=

1
/][  

(Equation 1) 
 

where [TP] is the loch total P concentration in micrograms per litre (µg/l), J is the sum of 
inputs of P in milligrams per year (mg/yr), TW is the water residence time in years and a and b 
are model parameters. 

For lochs with a mean depth of >= 3 m, (a, b) = (1.55, 0.82). For shallow lochs with a mean 
depth < 3 m, (a, b) = (1.02, 0.88). The values a and b for each water body are read from the 
LoadPrecursor table. Measured or modelled mean depths are available for all lochs are also 
in the LoadPrecursor data set. 

The water residence time, TW is calculated as follows: 

R
zATW =  

(Equation 2) 

where A is the area of the loch in square metres (m2), z is the mean depth in meters and R is 
the runoff in cubic metres per year (m3/yr). Runoff is available for all lochs in the database. It 
is calculated in the following manner: 

∑+= UpL RjAR  
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(Equation 3) 

where j is the local runoff in m/yr (this value was taken from the model NIRAMS [Dunn 
2004]), A is the local catchment area in m2 and sum of RUp is the sum of upstream runoff 
which can be calculated from upstream inflows.  

The sum of inputs of phosphorus, J, is calculated in the following manner: 

∑ ∑++++= UpUpiiL TPRyxsLpAJ ][  

(Equation 4) 

where the first term is the sum of the different phosphorus loads for the different proportions 
of land cover classes, s is the sewage load (WWTW and septic tanks), x is the sum of any 
additional point source inputs and y is an alteration that a user  may wish to make when 
running a scenario. The last term is the sum of upstream inputs. The equation is solved in a 
cascading manner, starting with 0 Strahler order lochs and proceeding down a chain of 
connected catchments (each order summing the relevant and topologically determined 
upstream orders), making it possible to simulate TP concentrations for a series of connected 
lochs. 
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3. USING THE MODEL 

3.1 Hardware and software requirements and installation 
In addition to the personal geodatabases SourceData.mdb and ScenarioData.mdb the VBA 
form frmCatch, SEPA tables described above and the SEPA ArcMap template 
SEPA_A4.mxd are also required. The form contains the interface and the programming code 
of the application. The specified MXD file is required to ensure that the report formatting is 
correct. The application was written in the VBA environment of ArcGIS version 9.3.1 and has 
subsequently been updated to 10.2. It is possible that the application will run on older 
versions of ArcMap, but this has not been tested. The application does not have any 
dependence on an ESRI extension. The VB code has been extensively commented 
throughout. 
 
The form should be imported into Project → Normal within the VBA environment. In some 
installations the Visual Basic environment may be unavailable (in ArcMap Tools → Macros 
→ Visual Basic Editor will be greyed-out). If this is the case please contact your IT 
department to request VBA installation using the following two files: “VBAOF11.msi“ and 
“VBAOF11I.msi “. Note that for versions 10.1 and 10.2 of ArcGIS an additional VBA licence 
is required, see Appendix D for more information. 
In some installations there may be missing references. This will be indicated by PLUS+ 
failing to load data with an error message such as a library error on a command such as 
“Mid” within the computer code. This can be corrected in the Microsoft Visual Basic editor by 
selecting Tools → References and then by scrolling down the list of Available References 
and removing ticks from any references which are described as “MISSING”. Note that the 
PLUS+ form must be closed for the References dialog to become available. 
Should access to the application be required from a custom user interface button the code in 
Appendix A should be inserted into the ArcMap ‘ThisDocument’ object in Normal.mxt. 
The VBA application requires Microsoft Windows Common Controls 6.0 (SP6) – this is in the 
library mscomctl.ocx. If this reference is not listed under the Microsoft Visual Basic section of 
ArcGIS (Tools → References) it may be necessary to download and install this library from 
Microsoft or run it from the icon below. The reference can be enabled in Tools → References 
within the Visual Basic environment (you may have to browse for the control – note that the 
default file type filter should be changed to ‘ActiveX Controls (*.ocx)’ in the file type filter). 

 
 

Note that following a modification to the system or ArcGIS installation that PLUS+ will 
possibly fail to load with an automation error as follows: 

 
To solve this reinstall the OCX library from this Word file using the VB6 executable above. 
 
The folder ‘c:\temp’ is used for the storage of temporary files during the intersection of user 
supplied land cover and source data. Please ensure that the folder exists. 
 
Please refer to ArcMap Help documents for instructions on customising ArcMap to include a 
button for the application. The code in Appendix A, below, expects the button to be named 
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“UIToolControl1”. If this name is not used then please modify any occurrences of 
“UIToolControl1” that you have copied into ‘ThisDocument’ in Normal.mxt (within the VBA 
environment). Alternatively the application can be started within the VBA environment. 
 

3.2 Getting started/obtaining default model output 
1) Open ArcMap and if necessary add the contents of the two personal geodatabases: 

SourceData.mdb and ScenarioData.mdb. Also add the SEPA look up table to relate 
GB Lakes and Water Body identifiers and the SEPA loch Water Body classification 
table. Add Ordnance Survey or other map data if required. 

 
2) If a custom button to the tool has been installed then click on it (highlighted in purple 

in the example above, your configuration may differ) to start the application (or start it 
through the VBA environment) and the following menu should appear. If at any time 
you close PLUS+ you will need to reopen the application – the state of the model is 
not stored (other than when scenarios are explicitly saved by the user to the scenario 
geodatabase). Selecting another tool within ArcMap will enable you to reselect the 
PLUS+ tool to restart the application. An additional information tool has been 
implemented in the source code such that if the LocalCatchment_and_Network layer 
is at the top of the table of contents then clicking on one of the catchments in the map 
window will display the GB Lakes ID and name of the catchment. 

3) The tool has been designed so that commands and options are context sensitive – 
buttons become available to click only when necessary conditions in the processing 
flow have been met or suitable options chosen or data loaded. As can be seen 
below, much of the application window is empty and the buttons and options greyed-
out to indicate to the user that they have been disabled. At this stage the only 
available processing option is to load input data (either source or scenario). Or to 
collapse or expand the tool (+ and – buttons in the top left corner). 

  

 

PLUS 

application 

button 
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4) To obtain and work with information from the default PLUS+ model populate the drop 

down boxes as follows: 

• Catchment polygons (highlighted in orange above) : 
“LocalCatchment_and_Network”, the polygon feature class containing the 
catchment boundaries 

• SEPA monitoring table (highlighted in green above): 
“SEPA_detailed_Loch_WB_classification”, geodatabase table containing 
High/Good etc. descriptions of water bodies and the classification year 

• GB Lakes Water Body ID LUT (highlighted in yellow above): 
“GBLakes_WBID_lookup”, geodatabase or standalone table with 
WFD_WB_ID and GB_WB_ID fields 

• SEPA classification (highlighted in blue above): “SEPA_2009_loch_class”, 
geodatabase or standalone table with measured P concentration and year of 
classification 

5) When the four drop down boxes have been correctly configured click on “Load data” 
(highlighted in purple above). To work with previously saved scenario data see 
procedures described below. 

6) The “Load data” button will load the layers and tables selected in the four drop down 
boxes in addition to the tables in SourceData.mdb (and in scenario loading also 
ScenarioData.mdb). The use of drop-down selection boxes allows for flexibility in 
input data names, however you must ensure that the data structure of alternate 
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source files matches those described in this manual and supplied with the PLUS+ 
MXD file. 

7) Following the clicking of “Load data” the application should appear as below. The 
loch of interest can be selected from the drop down boxes highlighted in orange 
(below) either through typing in the loch’s Water Body ID or GB loch ID or through 
scrolling down one of the lists (ID for Loch Lomond and Loch Awe are GB loch IDs 
for 24447 Loch Lomond and 24025 Loch Awe respectively [these two lochs are split 
in two within the GB lochs dataset]). Selecting a Water Body ID or a GB Lakes ID will 
automatically select the equivalent loch in the other menu it if exists in the tables 
used. Note that there are not Water Body IDs for every GB Lake in the data base. 
When PLUS+ is in use and the LocalCatchment_and_Network shapefile is displayed 
on the map (and uppermost in the table of contents and not in a group layer), clicking 
on a catchment in the map window will result in a box appearing with the associated 
loch’s name and ID. If the latter function is not available then use of ArcMap’s 
information tool will also provide this information within the “SITECODE” field of the 
layer “LocalCatchment_and_Network”. 

Clicking on “Get catchment info.” (highlighted in purple below) will load the selected 
catchment’s information into the application and take the user on to the next stage of 
using the model. 

  

8) The following network information box should appear (highlighted in orange) when 
“Get catchment info” has been clicked. This box highlights the GB loch and Water 
Body IDs (where available) of lochs either downstream from the chosen site (appear 
above the chosen site in the listing), those located upstream (appear below the 

Select catchment 
of interest using 
Water Body or 
GB lochs ID or 
loch name 

Obtains 
catchment 
information 
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chosen site) as well of those situated on a separate branch of the main river 
catchment (i.e. within the same main river catchment but not linked to the selected 
catchment directly by flow). 

 
 

It is now possible to zoom to or highlight the network of catchments related to the 
selected loch (see blue box below). If you select one of the lochs within the main 
scroll text list on the left this will automatically be highlighted within the map. 

Clicking “Calculate total phosphorus concentration….” (highlighted in purple below) 
will obtain estimates of total P concentration for each catchment in the scroll down 
box and take the user on to the next stage of using the model. 
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9) The information contained within the network information box (again highlighted in 

orange above) will change to include the following: 
- Status – a box will appear containing a colour representing the status of the loch 

calculated by comparing the estimated total P concentration to Water Framework 
Directive (WFD) boundary conditions (see Table 4 below for a summary of all 
colour options). Hovering the cursor over the individual box will provide a text 
description of the status. The water body which was selected by the user is 
highlighted by a “*”. 

Table 4 Summary of status colours 

 High 
 Good 
 Moderate 
 Poor 
 Bad 
 Not available (boundary data not available as loch is not a 

WFD water body) 
- SEPA RAG & Status – where available the Water Body ID, the calculated 

Red/Amber/Green (or “RAG”) SEPA warning classification for the measured 
concentration, and its status (H = High etc.) from the SEPA annual assessment is 
given. Note that there are more than two hundred water bodies for which Water 
Body ID exists but for which no SEPA measurement is in the supplied data. In 
these cases this column will contain only the Water Body ID. A comparison is 
made between the status in the SEPA standalone table selected by the user and 
the status of the measured value compared to the break points in the 
TPBreakPoints table in the SourceData database. Where there is a discrepancy 
between these assessments both values will be given in this column in the 
following format:  
 “100320 : G, TPBreakPoints = H”. 
This indicates that the SEPA monitoring table has a status of Good, but that the 
measured value corresponds to a status of High in the source database table. 
Note also that all RAG assessments compare the measured value with the status 

WFD status based 
on boundary data 

and estimated [TP] 

Estimated P 
concentration 

Total P 
load (kg) 

Basis of WFD 
boundary data (T- 

typology, S- modelled) 

Network 
information box 

Highlights or zooms 
to selected catchment 
or network in map 
window 
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derived from the TPBreakPoints table, and not the value in the SEPA 
measurement table. If the TPBreakPoints table contains inappropriate information 
then it should be updated manually or using the additional form tool supplied for 
the task (frmUpdateBreakPoints). 

- Site – GB lakes ID of loch. 
- PLUS+ modelled RAG & Site – the modelled Red/Amber/Green (or “RAG”) 

SEPA warning classification and the name given to the loch in GB lakes 
database. Hovering over this section will display the RAG colour as text. Refer 
also to the “Additional results” tab in the tool. 

- Order – stream order of the loch (Strahler system). Hovering the cursor over the 
order number will reveal the relationship of the highlighted loch to the selected 
loch (downstream, upstream, separate branch or chosen water body). 

- TP (µg/l) – total P concentration in µg/l within the loch estimated by PLUS+. Note 
that where a SEPA measured value exists in the user selected SEPA 
classification table for the TP this can be viewed by hovering the cursor over this 
field. The measurement will appear as e.g. “Meas: 7.7”, the units being the same 
as those of the PLUS+ calculation.  

- J (kg) – the sum of inputs of P to the site in kg (including local catchment land 
cover, local catchment point sources and upstream inputs). A back-calculated 
estimated J for those water bodies with SEPA concentrations is included in a 
hover-over tooltip. Please note that these values are estimated from the SEPA 
concentration and include upstream and local run-off. 

- Ref. type – identifies the reference type - whether the WFD condition boundary 
information is based on typology (T), on values specifically modelled for the site 
(S) or not available as the loch is not a WFD water body (not av.). 

 
To avoid designing a form which occupies the whole of a user’s screen several of the 
remaining output columns scroll off to the right of the network information box, the figure 
below has been scrolled to the right to display these values. The display of capacity to 
upgrade and downgrade is dependent on the water body status – if the status is high then 
upgrade capacity is not available, if the status is poor then downgrade capacity is not 
available. 
 

 
 
The calculated (modelled) and measured load and concentration are compared to the values 
in the TPBreakPoints table (or the TPBreakPoints_S table in the case of a loaded scenario 
being analysed). The capacity to upgrade is displayed with a negative number to remind the 
user that this amount must be removed from the system to effect an upgrade. These 
capacities are local to the water body and do not take account of downstream effects. 
Applying changes to a catchment will have consequential effects downstream as with the 
application of any additions or removals. 
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- Cap. To down, TP – the remaining capacity in calculated (modelled) 
concentration before the assessment is downgraded to the next lower quality 
status. 

- Cap. To down, J – the remaining capacity (i.e. how much P can be added) in 
calculated (modelled) load before the assessment is downgraded to the next 
lower quality status. 

- Cap. To upgrd, TP – the required reduction in calculated (modelled) 
concentration required before the assessment is upgraded to the next higher 
quality status. 

- Cap. To upgrd, J – the required reduction in calculated (modelled) load required 
before the assessment is upgraded to the next higher quality status. 

- Meas. Cap. To down, TP – the remaining capacity in measured concentration 
before the assessment is downgraded to the next lower quality status. The 
measured concentration is compared to the SourceData TPBreakPoints table. 

- Meas. Cap. To down, J – the remaining capacity in measured load before the 
assessment is downgraded to the next lower quality status. 

- Meas. Cap. To upgrd, TP – the required reduction in measured concentration 
required before the assessment is upgraded to the next higher quality status. 

- Meas. Cap. To upgrd, J – the required reduction in measured load required 
before the assessment is upgraded to the next higher quality status. 

 
An additional box of local catchment land cover information (highlighted in yellow below) will 
also have appeared with the results. 

 

  
This box provides the following: 

Chosen catchment 
summary report 
(enlarged below) 

The James Hutton Institute & SEPA 15 



Phosphorus Land Use and Slope (PLUS+) User Guide 

- Site – the GB lakes ID of the selected loch. 
- P (kg) – total P load in kg from the relevant land cover type within the local 

catchment(see NB below) (sum of the P load calculated for the different areas of that 
land cover within the local catchment considering slope). 

- Land cover – land cover class taken from LCS88 data. 
- Area (m2) – total area of LCS88 land cover type in the local catchment of the loch 

in m2. 

NB local catchment refers to the land where water drains to the loch of interest without 
passing through any other lochs included within the model. P from land draining to 
upstream lochs is routed by the model via the upstream lochs and is represented by P 
from upstream in “sum P” (at the bottom of the box, see below). 

Scrolling to the bottom of this box (see additional yellow box below) provides the 
following information: 

- Sum P – this is the modelled total P in kg coming from the local catchment land 
cover, local catchment point sources and from upstream (if applicable). 

- Sum land cover inputs – the sum of P in kg modelled as coming from the land 
cover in the local catchment. 

- Sum upstream inputs – modelled total P coming from the loch upstream (this 
will include the P from lochs further upstream). 

- Urban – modelled P load in kg coming from urban WWTWs. 
- Urban population – number of people classified as living in urban areas by 

PLUS+ (see section 2.3.2 for default assumptions). 
- Rural – P load in kg coming from septic tanks. 
- Rural population – number of people classified as living in rural areas by 

PLUS+ (see section 2.3.2 for default assumptions). 

10) Further results are available in the ‘Additional results’ tab. 
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This section is in two parts. In the upper part there is a graphical representation of how close 
a calculated TP (in this case a value of 7.59) is to the nearest break point. This also shows 
the RAG classification within the quality assessment. In the above example the calculated TP 
is between Moderate/Good and Good/High. Adding or removing sources of P (and 
recalculating total P) while evaluating scenarios will move the red block’s position relative to 
the break point markers. Note that in the above example a significant amount of modelled 
point source P has been added to the base line total P for Loch Rannoch for illustration 
purposes. 

The lower part of this tab gives a tabular output of model parameters not available in the first 
tab of PLUS+. Run-off, the OECD parameters used to solve the model and the area and 
mean depth of the lochs used in the model solution are included. 

Note that in the source data 74 out of the 8030 lochs are listed as having a value of zero for 
area. These 74 include the two examples 22891 & 23224 shown above. Inspection of a 
number of these catchments (25369, 26878, 23876, 18261, 18323, 18062) has shown that 
these catchments do not have a significant body of standing water, many are actually rivers. 
For these catchments the result of the calculation of water residence time is zero (Equation 
2, above), resulting in a calculation of TP for these catchments of: 

baJTP =][
, rather than 

b

WT
JaTP 











+
=

1
][  

 
It must be noted that the OECD equations are only valid for lakes where annual TP load and 

The James Hutton Institute & SEPA 17 



Phosphorus Land Use and Slope (PLUS+) User Guide 

annual turnover control the observed TP. This approach (as adopted in PLUS+) is not 
appropriate for rivers as they have a different dynamic and TP is controlled by additional 
factors. 

 

3.3 Modifying the default model/scenario model output  
3.3.1. Land cover modifications  

3.3.1.1. Bulk changes to land cover area or loss coefficient 

PLUS+ allows bulk changes to local catchment land cover areas, including a check sum to 
ensure that the total catchment area is not unintentionally changed. The exports due to land 
cover are affected by the underlying slope. Altering land cover area using this bulk change 
removes the influence of slope. Unless the loss coefficient for the land cover is changed 
using the supplied function (either in the local catchment or within the entire network) PLUS+ 
will automatically use the loss coefficient for medium slope. To retain the influence that slope 
has on P export due to land cover, new land cover polygon data should be imported (see 
section 3.4.1.2). As just mentioned, the model also allows bulk changes to be made to the 
loss coefficient associated with a land cover either within the local catchment alone or the 
entire network associated with the catchment. Again changing the loss coefficient in this 
manner removes the influence on slope with a single loss coefficient being used for the land 
cover regardless of the slope. To make slope specific changes to the loss coefficients the 
baseline input data of the model must be changed. 

Getting started 

1) Obtain the default model output for the loch of interest (section 3.2) or load the 
relevant scenario you wish to use as a baseline (section 3.5) and obtain the model 
output for the loch of interest (section 3.2). 

2) Selecting a land cover within the local catchment land cover information table 
(highlighted in yellow below) by clicking on the relevant row of the table will cause 
options to appear (highlighted in orange below) which allow bulk changes in the area 
(m2) of the land cover in the local catchment or P loss coefficient (kg/ha) coming from 
that land cover in the local catchment. 
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Bulk land cover change 
1) Select the land cover you wish to change in the local catchment land cover 

information table (box highlighted in yellow above), enter your new value of the area 
of the selected land cover and ensure that the check box to the left of “Change area 
of …” is ticked (highlighted in yellow below), select the option to “Use modified 
values” (highlighted in orange below and disabled by default) and then click the 
“Modify inputs” button (highlighted in purple below). This process can be repeated for 
any number of land cover units, however ‘Modify inputs’ must be clicked after each 
modification to commit it to the model. Following your modifications information 
similar to that below will appear (highlighted in red, blue and green) which will allow 
you to modify other land cover values to ensure the total area of the catchment does 
not change (see step2). 

Resets values to the default 
values of the model 

Bulk change to loss 
coefficient for land cover  

Select before re-running 
model to run model with 
modified values or default 
values 

Press to re-run model 

Bulk change to area of 
land cover 

To apply loss coefficient change 
for land cover throughout network 
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2) PLUS+ will automatically detect when the model has been run using modified values 
which cause a total increase or decrease in local catchment area (highlighted in red 
above) and provide options to resolve this. Using the drop down box (highlighted in 
green above) or by clicking on a land cover type in the text window above it the user 
can select a land cover the area of which they wish to amend to resolve the change in 
catchment area, then clicking the “Resolve area difference…” button (highlighted in 
blue) the area difference will be resolved through changes to this one land cover. If 
the user wishes to resolve the difference by making changes to multiple land covers 
they will need to do this by repeating step 1 for multiple land cover units. Once 
resolved the model can be run using these new values by ensuring “Use modified 
values” is selected (highlighted in orange above) and pressing the ”Modify inputs” 
button (highlighted in purple above). Should a number of changes to the amounts of 
different land cover be required it is recommended that the user do this through 
creating and saving and then loading scenarios, building up the new arrangement 
incrementally. 

3) If you wish to introduce a land cover which is not present in the base line of your 
selected catchment you must first reduce the area of one of the existing land covers. 
When this has been applied by clicking ‘Modify inputs…’ a drop-down menu will 
appear containing all land covers in the model for you to select one and reconcile the 
area discrepancy now in the model. Note that you must click the ‘Resolve area 
difference button’ highlighted in blue above. Clicking on ‘Modify inputs…’ will not 
implement this change. To subsequently modify one of the existing land covers you 
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should select it from the information window above and not from the drop down menu 
highlighted in green. The drop down menu highlighted in green should only be used 
to introduce new land covers not present in the base line data. 

4) To return to the default/base line data values click on “Reset modified values”. You 
will be prompted to confirm this action before it is executed. 

5) To save changes as a scenario see section 3.4. 

To make bulk changes to land cover in other catchments within the network see 
instructions on saving scenarios and working from scenarios (section 3.5). These 
processes will allow a series of additional changes to be made within a network i.e. make 
changes to one catchment, save as a scenario, open scenario, and make changes to 
another catchment within the network and save a new scenario. It is not possible to make 
incremental changes to a number of catchments within a network without using scenario 
saving and loading. 

Bulk loss coefficient change 
1) Select the land cover you wish to change in the local catchment land cover 

information table (highlighted in red below), click on “Change P of export coeff. of …” 
to select the option and enter the new coefficient value in the box in kg of P per 
hectare (highlighted in yellow below). If you wish to apply this loss coefficient change 
for that land cover type throughout the network select “Change P export coeff. for …. 
for whole network” (highlighted in green below) otherwise this change will only apply 
to the selected catchment (e.g. 22782 in the example below). This process can be 
repeated for any number of land cover types by selecting them in turn and clicking 
‘Modify inputs…’ (highlighted in purple below) with “Use modified values” (highlighted 
in orange below) selected. 

Again it should be noted this change will remove the influence of slope from the 
model, applying the same coefficient for that land cover type regardless of slope and 
that this will apply to the whole network if that checkbox is ticked. 

 
2) To return to the default/base line data values click “Reset modified values”, this will 

undo all changes. 
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3) To save changes as a scenario see section 3.4. 

3.3.1.2. New land cover data 

User supplied land cover can also be used in this application. This functionality is part of 
the scenario section of the application. The user supplied land cover (which must be 
generated outside of the PLUS+ tool) is inserted into a subset of the land cover data 
corresponding to the catchment network selected by the user. If the new land cover that is to 
be implemented extends over more than one catchment network then the user must take 
account of this by processing all required networks individually. PLUS+ will only process the 
selected network (and will only process one network at a time, ignoring unconnected 
networks). Altering the land cover using this approach ensures slope is still considered by 
PLUS+ (assuming that slope information is provided in the user supplied data) when 
assigning loss coefficients. 

1) Generate polygon of new land cover data outside of PLUS+. 

PLUS+ requires that the user supplied polygon land cover data includes the following named 
field: 

• GridCode – contains the three digit slope/land cover code (see table Exports within 
the geodatabase for the full list of available codes) 

Below is an example of the table structure required: 

 
Note that these values are hardcoded and are case and data-type sensitive. ‘GridCode’ must 
be a ‘long’ to ensure that the correct type of data is supplied for processing. The GridCode 
value is used to obtain land cover export values from the Exports table in the SourceData 
database (AverageExp and LCOVDESC in the above example are just for illustration and are 
not used). The first character in the three figure code is used to identify the slope class but is 
ignored in this module in favour of obtaining the slope part of the code (and subsequently the 
appropriate slope determined export) from the underlying base data. 
 

2) Add the new polygon to the ArcMap table of contents in the normal manner. 

3) Obtain the default model output for the site of interest in PLUS+ (section 3.3) or by 
loading the relevant scenario you wish to use as a baseline (section 3.5). Note that 
the user entered land cover polygon should at least in part overlay the network of the 
selected catchment. This can be checked using the highlight network function in 
PLUS+. As stated above the land cover update will only be undertaken for the 
selected network. If there are several networks of interest these will each need to be 
modelled individually.  

4) To initialise the import select the “Create and save scenario” tab (highlighted in purple 
below) and enter the data required by the SEPA standard operating procedure for 
PLUS+ modelling. The scenario ID will automatically update to the next available 
number within the scenario database or another number may be entered by the user. 
Do not click on “create scenario”, in this use-case this tab is being used only to 
initialise the import. Ensure that the ‘Use original data’ setting is selected 
(highlighted in yellow below). If you require to modify the land-cover coefficients it 
should be done after you have imported the new polygons. 
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5) Select the “Import user created land cover polygon(s)” tab (highlighted in purple 

below). Before using the tool please take time to read the information provided in the 
tab, as shown below. Within this window ensure the Scenario ID (highlighted in yellow 
below) matches the one assigned in the “Create and save scenario” tab (see step 4). 
Select the new land cover shape file created in step 1 in the drop down box 
highlighted in orange below, and assign a name to the resulting land cover/slope 
layer that will be formed in this process within the box highlighted in blue below. This 
output shapefile will be saved in “c:\temp”. By default the layer containing the slope 
class/land cover class data should automatically be selected in the drop down box 
highlighted in green below, however you must check that this is correct. Decide 
whether you would like to retain or delete the intermediate files created by the 
process using the option highlighted in the white box below. The intermediate files 
may be useful in subsequent processing. 
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6) Click the “Overlay shape files” button (highlighted in red above). This will start the 

computation process to develop a slope-class – land cover feature class of the 
overlay (intersection) of the user supplied shapefile and the base line feature class in 
the Scenario PGDB for the selected network. The base line data layer is very large 
therefore this process will take some time (possibly several minutes) even for a small 
catchment or small change. Once successfully processed a window with a “Done” 
message will pop up and the new slope class/land cover polygon will appear in the 
map window. Do not click any other buttons or tabs in ArcMap until the “Done” 
window appears or processing may be interrupted and the application may crash. 

The scenario will be automatically saved in the PGDB ScenarioData.mdb using the 
details entered in step 4 in the “Create and save scenario” tab. Further processing of 
the scenario just created will use the tables in the Scenario PGDB as input data – the 
shapefile output will not actually be used, but is available to the user. 

If the scenario ID has been used previously an error message will occur identifying 
that the information will not be saved. The process should be started again from step 
4 using a new unique scenario ID. 

This part of the application requires an ESRI function which is known to crash fairly 
frequently, and has no known solution. This known bug has not yet been addressed 
by ESRI. If an error message appears during this processing phase then ArcGIS will 
need to be closed and the process started again from step 2. It is likely that the user 
will encounter software crashes if this function of the application is used regularly. In 
testing during the development of this software it was found that the shutting down 
and then restarting ArcMap has resulted in subsequent successful execution of the 
overlay process. Standard GIS approaches can also be used to update the 
SlopeClass_LandCover feature class and the CatchP table which contains the P 
export for each land cover for each catchment. 
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7) To view the new model output for the network and to make further bulk changes it is 
necessary to load the scenario just created (refer to section 3.5). 

For more extensive modifications to the land cover we would recommend editing the 
SlopeClass_LandCover feature class (or alternatively replacing it with an entirely new 
dataset) and then intersecting it with the LocalCatchment_and_Network feature class 
and summarising on the SITECODE attribute to produce a replacement CatchP table. 
Important Note: in PLUS+ the CatchP table in SourceData.mdb supplies the P 
export for each land cover in each catchment, it is vital that this is updated when the 
baseline land cover data set is modified. 

3.3.2. Modifications to point sources 

Within the model it is possible to make bulk changes (increases and decreases) to the point 
sources for the site of interest, including: 

- The load of P entering the site per person separately for the urban and rural 
population.  

- The total rural and/or urban population of the local catchment.  
- An additional bulk P load (positive or negative) to represent other P sources or 

losses from the system. During the creation of a report the default text is 
modified when an additional point source is introduced by the user to ensure 
that it is recorded. 

These options can be used, for example, to represent inputs from WWTWs within the local 
catchment servicing populations located outside of the local catchment or other specific 
known sources of P e.g. birds. Additionally these could be used to adjust a model run to 
make it more accurately reflect measured P concentrations. 

3.3.2.1. Waste water treatment and other point sources 

1) Obtain the default model output for the site of interest (section 3.3) or load the 
relevant scenario you wish to use as a baseline (section 3.5). 

2) Within the “Modify point sources for…” box located in the lower right hand area of the 
model screen (highlighted in blue below) enter a new per capita TP load (loss 
coefficient) for rural/urban population (boxes highlighted in red below) and/or a new 
urban/rural population in the boxes (highlighted in green below). Values recorded next 
to each sub-heading (e.g. Urban = 0.913) are the default values. 

 

 

3) Point sources of P can be added using the “Select other point source type to add” 
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(highlighted in black above), one of the default types may be chosen or a new type 
typed into the window. A positive (source) or a negative (sink) value for P may be 
entered. 

4) Ensuring the relevant tick boxes are selected select “Apply changes” (highlighted in 
purple above) and the changes will be applied to the model output in the window 
highlighted in orange above. Pressing “Reset” (highlighted in yellow above) will rerun 
the model using the default values. If a source of P is listed in the information window 
(in orange above) then it is used in the model. To remove an item’s source from the 
model you must ensure that it is removed from the information window by clicking on 
it in the window highlighted in orange above, and then by clicking on the tick box 
indicated by the black arrow above, finally click on “Apply changes” and confirm that 
the item you have selected has been removed. When working with a loaded scenario 
the “Reset” button will reload the scenario from the database. 

5) To save changes as a scenario see the next section. 

 

3.4 Saving changes to default as scenarios 
Once the default model or a scenario has been built or modified using the steps outlined 
above in section 3.3 it is possible to save the changes to the relevant network as a new 
scenario using the steps described below. This feature of PLUS+ allows the changes and 
results to be revisited and for subsequent changes to be made, for example further changes 
to other catchments within the network can be made. For instructions on how to load 
previously saved scenario data see section 3.5. To make multiple changes within a network 
(apart from in the case of loading a new land cover data set or implementing the same bulk 
change to land cover coefficients) it is necessary to work on one local catchment at a time 
through working on and saving a series of scenarios. After a scenario has been saved and 
reloaded any catchment within the saved network is available for further incremental 
scenario development. The information will be saved in the personal geodatabase 
ScenarioData.mdb. 

1) Once you have made and are satisfied with your changes to the default 
model/scenario (see section 3.3) select the “Create and save scenario” tab 
(highlighted in purple below) and enter the data required by the SEPA standard 
operating procedure for PLUS+ modelling. The scenario ID (highlighted in green 
below) should have automatically updated to the next available number within the 
“Scenario” table in the scenario database. The Scenario owner field will be 
automatically populated with the logged in user’s identifier. By default the Scenario 
comment field will refer to the name of the computer being used. Ensuring “Use 
modified data” is selected (highlighted in yellow below) select “Create scenario” 
(highlighted in blue below). The “Use original data” option is provided to allow the 
saving of baseline data into a scenario. Under this option the application will always 
revert to the baseline (i.e. non-scenario and unmodified) data, even if scenario data 
has been loaded and processed. The user is given a warning message if this option 
is chosen within a scenario processing session. 
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3.5 Working with previously saved scenarios 
1) To open a previously saved scenario select the “Click to load from scenario” button 

(highlighted in purple below) located in the top right hand corner of the model tool at 
any point. 

 

 

2) A number of options will appear to aid the selection of the required scenario 
(highlighted in blue below). The scenario will be loaded based on the ID in the 
scenario ID box (highlighted in green below). To reduce the scenario ID list the list 
can be filtered using: 

- Scenario name. 
- Scenario owner. 
- Scenario date. 
- Scenario comment. 

The desired filtering criteria can be selected from the relevant drop down box and the 
tick box associated with the filter selected to apply it. The information in these filters is 
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the information entered and saved when creating earlier scenarios (Section 3.5). 

To view the filter information associated with a particular ID select the appropriate ID 
in the drop down list and then select the Scenario ID tick box (highlighted in yellow 
below). 

To load the scenario select “Load scenario” (highlighted in purple below). 

 

 
3) As in a default model workflow (section 3.3) the following should appear. The only 

difference is that the list of sites for selection (highlighted in yellow below) has been 
reduced to only include those catchments in the network for which the scenario was 
created. This data can be explored using the steps in section 3.3, further modified 
using the steps in section 3.4 and saved as an additional scenario using the steps 
described above.  

  
Note you can return to using the default data at any point though selecting “Click to load 
from master” (highlighted in purple above) and following the steps outlined in section 3.3. 

The tables loaded by clicking the ‘Load scenario’ button can also be edited manually. For 
example the OECD denominator values could be manually edited from the standard 
values of 1.55 and 0.82 (for lochs of a mean depth >= 3m). The values stored in the 
various scenario tables are loaded with the scenario. 

3.6 Report writing 
1) Once you have made and are satisfied with the required changes to the default model 

or scenario, or simply to report on the base-line model, select the “Create a report” 
tab (highlighted in purple below) and enter the options required by the SEPA standard 
operating procedure for PLUS+ modelling.  
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To prevent erroneous reporting the ‘Create report’ button only becomes available when the 
‘Calculate total phosphorus concentration’ button in the ‘Analyse catchments’ tab has been 
clicked. 
 
When any user modifiable loads are changed with the ‘Modify land cover’ sections or the 
‘Modify point sources’ section the ‘Report contents’ box in the ‘Create a report’ tab is 
modified to disable the ‘Report on loaded data’ option. When modifications have been 
applied to the base line data within the application (outwith scenario loading and saving) the 
output is automatically adjusted to include the modifications and base line saving is disabled. 
Clicking to ‘Load data’, or ‘Reset modified values’ resets the user’s modifications and gives 
access to base line reporting. 
 
Using the path and root filename entered in the output window (the file output path defaults 
to the location of the MXD file currently in use, highlighted in yellow, above) the application 
will generate JPEG or PDF outputs (determined by the option box in green, above). These 
outputs consist of the following: 

• a map of the catchment or network (determined above, blue box) 
• a table of the various lochs in the network, their PLUS calculated values, modelled 

and measured status 
• land cover statistics of the chosen loch, including P, area and percentage of 

catchment of each land cover 
• modelled capacity to upgrade and downgrade status 
• measured capacity to upgrade and downgrade status 
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• a summary of the PLUS calculation. 

As noted above, PLUS+ will detect any discrepancy between the SEPA reported quality 
status and that derived from a comparison with the TPBreakpoints table. In addition to 
displaying this discrepancy in the main network information window the discrepancies will be 
written to a text output file using the root file name entered in the window highlighted in 
yellow above with the suffix “_StatusDiscrepancy.txt”. This file will be created for all options 
in the report creation tab. 
  
If land cover statistics (and any incremental scenario modifications) of all lochs in a network 
are required the user must step through each catchment in turn, calculating the total P 
concentration and creating separate reports. 
 
The quality of the PDF and JPEG outputs can be controlled to produce a high quality plot for 
printing or a lower quality plot suitable for electronic distribution (see green box above). 
 
The PLUS+ application also generates comma separated text files of the above outputs from 
the calculations using the path and root file name entered in the window (red box, above). 
These text files are suitable for loading into Excel or ArcGIS as a table. 
 
Creation of the reports will take from a few moments to several minutes to complete 
depending on computer speed, the number of catchments in the network and the number of 
land cover types in the selected catchment. PLUS+ will generate a report on the measured P 
concentration of the selected network of catchments. This will calculate an estimated total P 
load based on the measured P concentration and the local and upstream run-off. It must be 
emphasised that this is an estimated load. 
 
The application relies on the graphical elements (title, scale bar etc.) in the SEPA supplied 
map template SEPA_A4.mxd (see below). If any of the elements in the template are modified 
or an alternate MXD file is used it is highly likely that the layout of the output maps will be 
affected detrimentally. 
 
Please note that the creation of the JPEG and PDF reports requires PLUS+ to create table 
elements from lines and takes a considerable amount of processing. Networks consisting of 
more than a few catchments will take several minutes to process. Interrupting this processing 
will leave partially complete tables in the map layout of the MXD file and is very strongly 
discouraged. 
 
In addition to the creation of map and tabular reports comma separated value (CSV) files of 
the results of the modelling are created. These files include all the information described 
above and are suitable for importing to Excel or other system. In each file the first line 
describes the structure of the data. This is described in detail in Appendix C. 
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Please note the following: 

 
 The date of SEPA status in the summary P report is taken from the first record of the 

“CLASSIFICATION_YEAR” field in the SEPA_Loch_WB_classification table. 
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APPENDICES 
Appendix A. Code to implement the model with ArcGIS 
Private Sub UIToolControl1_Select() 

    frmCatch.Show 

End Sub 

 

Private Sub UIToolControl1_MouseDown(ByVal Button As Long, ByVal Shift As Long, ByVal X As 

Long, ByVal Y As Long) 

  Dim pMxDoc As IMxDocument 

  Dim pActiveView As IActiveView 

  Dim pPoint As IPoint 

  Dim pFeature As IFeature 

   

  Set pMxDoc = Application.Document 

  Set pActiveView = pMxDoc.FocusMap 

  'Create a search point 

  Set pPoint = pActiveView.ScreenDisplay.DisplayTransformation.ToMapPoint(X, Y) 

  'Pass the point to the FindFeature function along with the Map and search tolerance 

  Set pFeature = FindFeature(pMxDoc.SearchTolerance, pPoint, pMxDoc.FocusMap) 

  'Message box the feature ID and feature class alias name 

  If Not pFeature Is Nothing Then 

    If pFeature.Fields.FindField("SITECODE") <> -1 Then 

        MsgBox pFeature.Value(pFeature.Fields.FindField("SITECODE")) & " - " & 

pFeature.Value(pFeature.Fields.FindField("SiteName")), vbOKOnly 

    End If 

  End If 

End Sub 

 

Private Function FindFeature(SearchTol As Double, pPoint As IPoint, pMap As IMap) As IFeature 

  Dim pEnvelope As IEnvelope 

  Dim pSpatialFilter As ISpatialFilter 

  Dim pEnumLayer As IEnumLayer 

  Dim pFeatureLayer As IFeatureLayer 

  Dim pFeatureClass As IFeatureClass 

  Dim pFeatureCursor As IFeatureCursor 

  Dim pFeature As IFeature 

  Dim pUID As New UID 

  Dim ShapeFieldName As String 

   

  If pMap.LayerCount = 0 Then Exit Function 
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  'Expand the points envelope to give better search results 

  Set pEnvelope = pPoint.Envelope 

  pEnvelope.Expand SearchTol, SearchTol, False 

   

  'Create a new spatial filter and use the new envelope as the geometry 

  Set pSpatialFilter = New SpatialFilter 

  Set pSpatialFilter.Geometry = pEnvelope 

  pSpatialFilter.SpatialRel = esriSpatialRelIntersects 

 

  'Search each selectable feature layer for a feature 

  'Return the first feature found 

  pUID = "{40A9E885-5533-11D0-98BE-00805F7CED21}" 'IFeatureLayer 

  Set pEnumLayer = pMap.Layers(pUID, False) 

  pEnumLayer.Reset 

  Set pFeatureLayer = pEnumLayer.Next 

  Do While Not pFeatureLayer Is Nothing 

    'Only search the selectable layers 

    If pFeatureLayer.Selectable Then 

      ShapeFieldName = pFeatureLayer.FeatureClass.ShapeFieldName 

      Set pSpatialFilter.OutputSpatialReference(ShapeFieldName) = pMap.SpatialReference 

      pSpatialFilter.GeometryField = pFeatureLayer.FeatureClass.ShapeFieldName 

      Set pFeatureClass = pFeatureLayer.FeatureClass 

      Set pFeatureCursor = pFeatureClass.Search(pSpatialFilter, False)  'Do the search 

      Set pFeature = pFeatureCursor.NextFeature  'Get the first feature 

      If Not pFeature Is Nothing Then 

        Set FindFeature = pFeature  'Exit if feature is valid 

        Exit Do 

      End If 

    End If 

    Set pFeatureLayer = pEnumLayer.Next 

  Loop 

 

End Function 
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Appendix B. Application code and notes 
 

Notes and commentary are provided within the code for the benefit of developers and 

support staff. 

 

Within the “Activate” routine of the code the tables are hardcoded as follows: 

strTblCatchmentSewageName = "CatchmentSewage" 

strTblCatchPName = "CatchP" 

strTblExportsName = "Exports" 

strTblFlowRouting = "FlowRouting" 

strTblLoadPrecursorName = "LoadPrecursor" 

strTblPerCapitaTPLoadsName = "PerCapitaTPLoads" 

strShapefileSlopeClass_LandCover = "SlopeClass_LandCover" 

strTblTPBreakPointsName = "TPBreakPoints" 

strFieldGRIDCODE = "GridCode" 

strFieldAverageExport = "AverageExp" 

 

'initialise the Scenario names 

strScenarioLocalCatchmentAndNetwork = "LocalCatchment_and_Network_S" 

strScenarioTblCatchmentSewageName = "CatchmentSewage_S" 

strScenarioTblCatchPName = "CatchP_S" 

strScenarioTblExportsName = "Exports_S" 

strScenarioTblLoadPrecursorName = "LoadPrecursor_S" 

strScenarioTblPerCapitaTPLoadsName = "PerCapitaTPLoads_S" 

strScenarioTblTPBreakPointsName = "TPBreakPoints_S" 

strScenarioTbl = "Scenario" 

strScenarioTblPointSource = "PointSource_S" 

 

Should alternate table names be required then they should be edited in the “Activate” section 

of the VBA code – e.g. “CatchmentSewage” could be modified to “NewCatchmentSewage”. 

Alternatively the name in the table of contents of a replacement table could be altered to 

ensure that the original configuration is maintained – the actual table name is not relevant as 

it is the name shown in the table of contents that is used to access the table. 

 

The configuration for the loading of SEPA monitoring data is stored in the sub-routines 

LoadSepaMonitoringIntoArray() and LoadSepaClassConcStat() using the ArcObjects 
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FindField method. If the field names to be used are different to those coded then lines of 

code such as: 
pSEPAmonitoringArray(lonCounter, 0) = pRow.Value(pSEPAmonitoringTable.Table.FindField("WATER_BODY_ID")) 

can be manually edited (changing “WATER_BODY_ID”). An accompanying test line such as: 

intField = pSEPAmonitoringTable.Table.FindField("WATER_BODY_ID") in the same sub-routine must also be 

edited to contain the changed field name. 

 

 

Separate file (10,000+ lines of code). VBA forms are embedded in attached zip file which 

should be unzipped and imported into the VBA project of your MXD file as described above. 

 

PLUS_2014.05.02.zip
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Appendix C. Text output file structure 
The naming of the text files follows a structure “root”_”suffix”, where “root” is a user entered 

name and “suffix” is supplied by PLUS+ and includes “Summary”, “CatchP” etc. In the listing 

below only “suffix” is shown. 

Summary 

ID  GB Lakes ID 

WBID  Water body ID 

SumP  Sum P loads (kg) 

SumLCover Sum land cover input (kg) 

SumUpstream Sum upstream input (kg) 

UrbanPop Urban population (number) 

UrbanP  Load due to urban population (kg) 

RuralPop  Rural population (number) 

RuralP  Load due to rural population (kg) 

 

CatchP 

ID  GB Lakes ID 

WBID  Water body ID 

SiteName Name of water body 

ModelledStatus Modelled P status (High etc.) 

SEPAStatus Status in user selected SEPA classification table 

Order  Strahler order 

ModelledTP Modelled total phosphorus concentration (microgram per litre) 

J  Modelled total phosphorus load per year (kg/year) 

MeasTP Measured total phosphorus concentration (microgram per litre) from user 

selected SEPA classification table 

DerivedJ Derived estimated total phosphorus load per year (kg/year), back 

calculated from MeasTP 

RefType  Reference type (see Section 3.2.9 above) 

 

PointSource 

ID  GB Lakes ID 

WBID  Water body ID 

PointSource Description of point source 

Amount  P due to point source (kg) 

 

LandCoverP 

The James Hutton Institute & SEPA 36 



Phosphorus Land Use and Slope (PLUS+) User Guide 

ID  GB Lakes ID 

WBID  Water body ID 

P  Load due to specified land cover per year (kg) 

LandCover Type of land cover 

Area  Area of land cover in catchment (m) 

 

Capacity 

ID   GB Lakes ID 

WBID   Water body ID 

SiteName  Name of water body 

ModelledTP  Modelled total phosphorus concentration (microgram per litre) 

J   Modelled total phosphorus load per year (kg/year) 

MeasTP Measured total phosphorus concentration (microgram per litre) 

from user selected SEPA classification table 

DerivedJ Derived estimated total phosphorus load per year (kg/year), 

back calculated from MeasTP 

TP Mod.Cap.to downgrade Total P concentration, modelled capacity to downgrade 

(microgram per litre) 

J Mod.Cap.to downgrade Total P load, modelled capacity to downgrade (kg/year) 

TP Mod.Cap.to upgrade Total P concentration, modelled capacity to upgrade 

(microgram per litre) 

J Mod.Cap.to upgrade Total P load, modelled capacity to downgrade (kg/year) 

TP Meas.Cap.to downgrade Total P concentration, measured capacity to downgrade 

(microgram per litre) 

J Meas.Cap.to downgrade Total P load, measured capacity to downgrade (kg/year) 

TP Meas.Cap.to upgrade Total P concentration, measured capacity to upgrade 

J Meas.Cap.to upgrade Total P load, measured capacity to downgrade (kg/year) 

 

CatchRelationships 

ID  GB Lakes ID 

WBID  Water body ID 

SiteName Name of water body 

Relationship Relationship between catchment and the chosen catchment (e.g. “Is 

Upstream”) 

ChosenSite The GB Lakes ID. 
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Appendix D. Migration to ArcGIS 10.2 
Note that when I most recently updated my PC to 10.2 the only adjustment required was to 

tick the “Microsoft Windows Common Controls 6.0 (SP6)” box. 

Following the installation of ArcGIS 10.2 you must: 

1. Install the ArcGIS 10.2 VBA Compatibility application. 
2. Open ArcGIS 
3. Under the ArcGIS “Customise” pull down open VBA Macros -> Visual Basic Editor to 

view the Microsoft VBA environment. 
4. Under Tools -> References ensure that “Microsoft Forms 2.0 Object Library” and 

“Microsoft Windows Common Controls 6.0 (SP6)” are ticked. If these are not 
available refer to the instructions above concerning mscomctl.ocx 

5. Import the form frmCatch_10.2.frm. frmCatch_10.2.frx frmCatch_10.2.frm
 

6. If the program runs but does not display the HGMPB colour icons then you will need 
to modify the ImageList as described below in section 15. 

7. If you initially see the message window “Could not load some objects because they 
are not available on this machine.” Then follow these instructions: 

8. Exit ArcMap. 

In the folder C:\Documents and Settings\"UserName"\Application 

Data\Microsoft\Forms delete the contents, these will be recreated as needed.  

 

If the errors “Could not load some objects because they are not available on this machine” 

and “Could not load an object because it is not available on this machine” persist then it 

could be easier to replicate the missing items from another installation – this only takes a 

couple of minutes. 

 

9. Import a copy of the form, if this does not load all the parts so they need to be 
manually added, this only takes a few seconds. 

10. Open the form (View Object) and click on it. This should display the Toolbox of 
objects that can be added to the form. If it doesn’t click View -> Toolbox 

11. Right click on the toolbox and choose “Additional Controls” – the missing parts are 
not part of the standard installation of VBA. 

12. Find and select “Microsoft ImageList Control 6.0 (SP4)” and “Microsoft ListView 
Control 6.0 (SP4)” 

13. Manually add the three missing ListViews (“lvwCatchmentInfo”, 
“lvwCatchmentRelationships1 “, “lvwCatchmentRelationships2”) to the front tab and 
copy only the names, size and position from the values in a working copy running in 
ArcGIS 10.1. 

a. lvwCatchmentInfo – left: 6, top: 102, height: 0, width: 409.5 
b. lvwCatchmentRelationships1– left: 6, top: 150, height: 0, width: 409.5 
c. lvwCatchmentRelationships2– left: 6, top: 159.75, height: 0, width: 669.75 
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14. Do the same for the ListView in tab 4 (“lstViewSupplement”) – all the other settings 
and attributes are created at runtime. This must go inside the frame in the lower half 
of the window of the “Additional results” tab. 

d. lvwCatchmentInfo – left: 0, top: 0, height: 252, width: 657.75 
15. Create the ImageList (“ImageList_Catchment”), this can be placed anywhere in the 

first tab as it is not displayed. Populate it with the images as required (HGMPB), 
making sure to populate the Key and Tag fields. The settings are changed by clicking 
on the “(Custom)” option of the ImageList and then the … button, this will display a 
dialog as below. The custom size is ht=12, w=21. 

 
 
The images below can be inserted. 

 

Saving and re-importing this modified copy should present no further problems. 
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